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Abstract

Considering that adipose tissue (AT) is an endocrine organ, it can influence whole body metabolism. Excessive energy storage leads to
the dysregulation of adipocytes, which in turn induces abnormal secretion of adipokines, triggering metabolic syndromes such as obesity,
dyslipidemia, hyperglycemia, hyperinsulinemia, insulin resistance and type 2 diabetes. Therefore, investigating the molecular mechanisms
behind adipocyte dysregulation could help to develop novel therapeutic strategies. Our protocol describes methods for evaluating the
molecular mechanism affected by hypoxic conditions of the AT, which correlates with adipocyte apoptosis in adult mice. This protocol describes
how to analyze AT in vivo through gene expression profiling as well as histological analysis of adipocyte differentiation, proliferation and
apoptosis during hypoxia exposure, ascertained through staining of hypoxic cells or HIF-1α protein. Furthermore, in vitro analysis of adipocyte
differentiation and its responses to various stimuli completes the characterization of the molecular pathways behind possible adipocyte
dysfunction leading to metabolic syndromes.

Video Link

The video component of this article can be found at http://www.jove.com/video/53822/

Introduction

According to the 2014 report from the World Health Organization, 39% of the world's adult population is overweight, and 13% is obese 1. In
the near future, overweight people will comprise a significant proportion of the elderly population. An important feature of obesity and aging
is dysregulation of fat in relation to morbidity and mortality 2. Adipokines, proteins secreted by the adipose tissue (AT), can trigger metabolic
syndromes such as obesity and type 2 diabetes 3. Metabolic diseases are mostly caused by excessive energy storage in the lipid droplets of
adipocytes, which results in AT expansion 4. It is therefore of interest to determine the causes and the molecular mechanisms of AT expansion in
order to find opportunities to control it.

Over-nutrition leads to AT expansion, which is regulated by two events: excessive energy storage into the lipid droplets of adipocytes, a process
leading to hypertrophy (increase in adipocyte size), and increased adipogenesis, also known as adipocyte hyperplasia 5. Adipogenesis is
a process of differentiation of multipotent mesenchymal stem cells (MSC) into adipocytes. Firstly, MSCs develop into preadipocytes during
the commitment phase. Secondly, preadipocytes further differentiate to acquire the features of mature and functional adipocytes 6. Several
transcription factors have been identified as master regulators for preadipocyte determination, such as zinc finger protein 423 (Zfp423) and
early B cell factor 1 (Ebf1). Whereas Zfp423 induces early commitment, Ebf1 is required for the generation of adipocyte progenitors 6. Terminal
differentiation is tightly controlled by a transcriptional cascade, whereby peroxisome proliferator-activated receptor γ (PPARγ) is the essential
transcription factor 7. Further key transcriptional factors are the CCAAT/enhancer-binding protein (C/EBP) family members (i.e., C/EBPα, C/
EBPβ, and C/EBPδ), kruppel-like factors (KLFs), cAMP responsive element binding protein (CREB) and early growth response 20 (Krox20) 6.

Recently, it has been shown that the activator protein-1 (AP-1) family is involved in the adipocyte differentiation process 8,9. The AP-1 family is
formed by a dimeric protein complex, composed of Fos, Jun and/or activating transcription factor (ATF) members. Fos-related antigen 1 and
2 (Fra-1 and Fra-2) are able to regulate adipocyte differentiation. Fra-1 impairs adipocyte differentiation by inhibiting C/EBPα 8, whereas Fra-2
controls adipocyte turnover 9. Fra-2 thereby not only decreases the adipocyte number by repressing PPARγ2 expression during adipocyte
differentiation, but also decreases adipocyte apoptosis through direct repression of hypoxia-inducible factors (HIFs) expression. The HIF family
is a heterodimeric transcription factor complex, composed of HIF-1α, HIF-2α and HIF-1β. The heterodimers consist of an oxygen-sensitive HIF-
α protein (HIF-1α or HIF-2α) and the oxygen-insensitive HIF-1β subunit 10. During normoxia, HIF-α proteins are poly-ubiquitinylated and are
finally degraded by proteasomes 11. Under hypoxic conditions, occurring in AT during expansion, HIF-α proteins are no longer hydroxylated.
They therefore become stabilized and form dimers with the constitutively expressed HIF-1β. Transcriptional activation of genes controlled by the
HIF response elements is involved in the regulation of angiogenesis, metabolism, and inflammation 12. Indeed, HIF-1α promotes AT dysfunction
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by inducing glucose tolerance, inhibiting energy expenditure and peripheral use of lipid, as well as by increasing leptin level and HFD-induced
hepatic steatosis 13. Moreover, HIF-1α regulates adipocyte apoptosis in vivo and in vitro9.

The present protocol describes methods for studying AT status to unravel the molecular characteristics of adipocyte homeostasis in adult mice.
It shows how apoptosis, proliferation and differentiation of adipocytes in vivo and in vitro can be regulated by hypoxia. To do so, we use mice
with adipocyte specific deletion of Fra-2 generated by crossing mice carrying the Fra-2 floxed alleles with Fabp4-CreERT mice 9. By using
Fabp4-Cre ERT mice, the deletion is adipocyte specific and inducible by tamoxifen injection 14. For the adult model, intra peritoneal injections of
tamoxifen are performed over 5 consecutive days starting at the age of 6 weeks. Thus, the mice are subjected to a normal diet or high-fat diet
for 6 weeks before the analysis is done. The mice used in this study were male based on a C57Bl6 background to avoid female hormones, such
as estrogens, shown to regulate the body fat distribution 15. Using another genetic background might also alter the metabolic phenotype, due to
strain-related differences in lipid management 16.

This protocol demonstrates how to analyze AT under hypoxia using histology and how to quantify adipocyte apoptosis, proliferation and
differentiation in vivo using immunohistochemistry and gene profiling analyses. The study is completed by in vitro experiments, showing how to
analyze primary adipocyte differentiation and apoptosis altered by exposure to hypoxia.

Protocol

ETHICS STATEMENT: Animals are housed in standardized conditions following the guidelines of the German Animal Welfare Act. Animals are
fed a standard diet and water ad libitum and kept with a 12 hr day/night cycle. All experiments with animals are authorized by the local ethics
committee.

1. In Vivo Analysis of Adipocyte Homeostasis in Adult Males

1. To quantify hypoxia in vivo, first determine the body weight of the mice, then inject 60 mg/kg body weight of solid pimonidazole hydrochloride
intra-peritoneally (for example: inject 1.5 mg into a 25 g mouse). Pimonidazole is an effective hypoxic marker, which forms adducts with thiol
groups in proteins, peptides and amino acids and is detected by a specific antibody.

2. Sacrifice mice and remove the perigonadal fat pads (Figure 1).
1. 45 min after injection, sacrifice mice by CO2 asphyxiation and subsequent cervical dislocation.
2. Pin down the limbs of mice (as illustrated in Figure 1) and open the peritoneal cavity. Remove the left and the right perigonadal

(epididymal) fat pad inside the peritoneal cavity.
 

Note: Fat pad are bound to the epididymis by the peritoneal leaflets as shown in Figure 1 (perigonadal fat pads are indicated by
arrows).

3. Take care to remove the gonadal tissues from the fat pad. Determine fat pad weights to calculate the ratio: fat pad weight (g) per body
weight (g).

 

Figure 1: Location of the perigonadal fat pads in the peritoneal cavity of mice. Picture of perigonadal fat localization in adult mice after
sacrifice. Perigonadal fat pads are indicated by the arrows. Please click here to view a larger version of this figure.

3. To compile a quantitative gene expression profile, use one perigonadal fat pad to isolate RNA. Note: Until the tissue is processed, store tissue
samples in RNA stabilization solution at -80 °C or in liquid nitrogen.

1. To homogenize the fat pad, add the fat pad to 1 ml single-phase solution of guanidine isothiocyanate and phenol. Use tubes containing
ceramic beads (1.4 mm) to crush the tissue in a homogenizer at 6,500 rpm (2 times 20 sec, with 30 sec pause).

2. Isolate the RNA as follows (single-step method by Chomczynski and Sacchi 17).
1. To separate the phases, transfer homogenized fat pad to microcentrifuge tube, add 0.2 ml volume chloroform, shake for 15 sec,

incubate for 5 min at room temperature and centrifuge 12,000 x g for 5 min. Transfer the upper aqueous phase (around 400 µl),
which contains the RNA, into a new microcentrifuge tube. Do not include the DNA-containing interphase or the protein-containing
phenol phase.
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2. To precipitate the RNA, add 1 volume of isopropanol, mix and incubate for 15 min at 4 °C (it is also possible to incubate at -20
°C overnight). Centrifuge at 12,000 x g for 10 min. Remove isopropanol supernatant carefully. Wash twice with 75% ethanol with
centrifuge steps of 12,000 x g for 10 min.

3. After drying the precipitated RNA for around 10 min at room temperature, dissolve it in 50 µl H2O (RNase-free). To facilitate this,
incubate for 2 min at 65 °C.
 

Note: Keep RNA in 75% ethanol at -80 °C or in liquid nitrogen for long-term storage.
4. Quantify the RNA preparations by A260/280 (optimal quotient is between 1.8 and 2.2) and calculate the concentration by A260:

 

3. To avoid DNA contamination, digest 1 µg of the RNA preparation with 1 U DNase I for 30 min at 37 °C in a volume of 10 µl. Inactivate
at 65 °C for 10 min.
 

Note: This step is optional.
4. Use 10 µl of RNA preparation containing 1 µg RNA for the reverse transcriptase reaction to generate single-stranded cDNA, suitable

for quantitative PCR application. The components and their amounts are listed in Table 1.
5. Use a PCR Master Mix for a quantitative real-time PCR reaction. To determine metabolic changes in the whole fat pad, use specific

primers for genes involved in AT homeostasis (Table 2) and the PCR conditions listed in Table 3.
6. Real-time PCR data analysis.

1. Define the baseline (Figure 2), normally cycle 1 to 15, where there is no change in fluorescence signals. The real-time PCR
software normalizes specific fluorescence signals to the baseline fluorescence and to the internal reference dye, ROX, resulting
in the magnitude of the specific signals by the primers, delta Rn (ΔRn).

2. Set the threshold within the exponential phase of the amplification curve. The intersection defines the threshold cycle (Ct). Based
on the CT value, calculate the relative expression (ΔCt) and the fold change (ΔΔCt):
 

 

Component Volume µl / reaction

10x RT Buffer 2.0

25x dNTP Mix (100 mM) 0.8

10x RT Random Primers 2.0

MultiScribe Reverse Transcriptase 1.0

Nuclease-free H2O 4.2

1 µg RNA 10

Total per reaction 20

Table 1: Components with respective volume for the reverse transcriptase reaction to generate single-stranded cDNA.
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Sequence 3´--> 5´Official full name Symbol

Forward Reverse

Delta-like 1 homolog
(pref-1)

Dlk1 GACACTCGAAGCTCA
 

CCTGG
GGAAGGCTGGGACGG
 

GAAAT

Early B cell factor 1 Ebf1 CCACCATCGACTACGG
 

CTTC
TCCTGGTTGTTGTGGGG
 

CATC

Zinc finger protein 423 Zfp423 GTGCCCAGGAAGAAGA
 

CGTA
GGCGACGTGGATCTGA
 

ATCT

Fatty acid binding protein 4
(Ap2)

Fabp4 TCACCTGGAAGACAGCT
 

CCTC
AAGCCCACTCCCACTTC
 

TTTC

CCAAT/enhancer binding
protein (C/EBP), alpha

Cebpa AAGAGCCGCGACA
 

AGGC
GTCAGCTCCAGCACCT
 

TGTG

CCAAT/enhancer binding
protein (C/EBP), beta

Cebpb TTTCGGGACTTGATGC
 

AATC
CCGCAGGAACATCTTT
 

AAGG

cAMP responsive element
binding protein 1

Creb1 ACTCAGCCGGGTACT
 

ACCAT
TTGCTGCCTCCCTGTT
 

CTTC

CCAAT/enhancer binding
protein (C/EBP), delta

Cebpd CAGCGCCTACATTGAC
 

TCCA
GTTGAAGAGGTCGGCG
 

AAGA

Kruppel-like factor 4 Klf4 GCAGTCACAAGTCCCC
 

TCTC
TAGTCACAAGTGTGGG
 

TGGC

Early growth response 2
(Krox20)

Egr2 AGGCGGTAGACAAAATC
 

CCAG
GATACGGGAGATCCAG
 

GGGT

Adipogenesis

Peroxisome proliferator
activated receptor gamma

Pparg AGAGGTCCACAGAGCTG
 

ATTC
GATGCACTGCCTATGAGC
 

ACTT

Acetyl-Coenzyme A
carboxylase alpha

Acaca TGGGGACCTTGTCTTCA
 

TCAT
ATGGGCGGAATGGTCTC
 

TTTC

Fatty acid synthase Fasn ACATCCTAGGCATCC
 

GAGA
CCGAGTTGAGCTGGGT
 

TAGG

Lipogenesis

Stearoyl-Coenzyme A
desaturase 1

Scd1 CGGGATTGAATGTTCTTG
 

TCGT
TTCTTGCGATACACTCTG
 

GTGC

Lipolysis Patatin-like phospholipase
domain containing 2

Pnpla2 AAGGACCTGATGACCA
 

CCCT
CCAACAAGCGGATGGT
 

GAAG

Lipoprotein lipase Lpl GTATCGGGCCCAGCAA
 

CATTATCC
GCCTTGCTGGGGTTTTC
 

TTCATTC
Fatty acid uptake

CD36 antigen Cd36 GTCTTCCCAATAAGCATGT
 

CTCC
ATGGGCTGTGATCGGA
 

ACTG

Hypoxia inducible factor 1,
alpha subunit

Hif1a CCTGCACTGAATCAAGAG
 

GTGC
CCATCAGAAGGACTTGCT
 

GGCT

Endothelial PAS domain
protein 1 (also known as:
HIF-2alpha)

Epas1 CAAGCTGAAGCTAAAG
 

CGGC
TTGGGTGAATTCATCG
 

GGGG

Von Hippel-Lindau tumor
suppressor

Vhl ACCGAGGTCATCTTTG
 

GCTC
TTCCGCACACTTGGGT
 

AGTC

Hypoxia

Aryl hydrocarbon receptor
nuclear translocator (also
known as: HIF-1beta)

Arnt TGGGTCATCTTCTCGC
 

GGTT
TGTCCTATCTGAGCAT
 

CGTG

Table 2: List of genes with sequence of the respective primers used for analyzing adipocyte homeostasis.
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Step Temperature (°C) Time (min:sec)

Polymerase activation Hold 95 10:00

Denaturize 95 0:15PCR 40 cycles

Annealing/Extension 60 1:00

Melting curve 60 to 95 0.5 °C/sec

Table 3: Real-time PCR conditions.

 

Figure 2: Characteristics of real-time PCR amplification curve. Please click here to view a larger version of this figure.

4. To perform histological analysis of the adipocyte homeostasis, use the second perigonadal fat pad. Do not desiccate the tissue!
1. Fix the fat pad in 3.7% PBS-buffered formaldehyde overnight, embed in paraffin (follow the instructions as described elsewhere 18) and

cut the embedded tissue into 2-5 µm thick sections (maximum 5 µm).
2. Determine the number of adipocytes per field and adipocyte size in a bright-field microscope after hematoxylin and eosin (H&E)

staining:
1. Deparaffinize sections by washing 3 times for 5 min in xylene and rehydrate the section 2 times for 2 min in 100% ethanol and 2

times for 2 min in 96% ethanol. Finally, wash the section in distilled H2O for 5 min.
2. Stain with hematoxylin, diluted 1:5 with distilled H2O, for 10 min at room temperature and wash in H2O for 5 min. Stain with eosin

solution (20 ml 5% eosin Y/210 ml distilled H2O/25 µl glacial acetic acid) for 30 sec and wash again with H2O for 5 min.
3. Dehydrate sections using 96% ethanol and 100% ethanol 2 times each for 2 min, and xylene 3 times for 5 min. Mount the

sections with anhydrous mounting agent.
4. Evaluate the sections under a bright-field microscope. A representative example of how to analyze adipocytes with ImageJ 1.48v

19 is shown in Fig. 3: number of cells per area (µm2), cell area (x 103 µm2), cell size (µm).
1. Open the picture of the section with ImageJ 1.48v. If the parameters of the image are indicated in pixels instead of a unit of

length, adjust the scale.
2. Select *Straight line* in the toolbar and adjust the line to a known distance by reference to the scale bar. Go to Analyze ->

Set Scale. The distance of the line is shown in pixels; add the known distance and the unit of length, e.g., µm. Confirm with
OK. The size of the picture and the analysis of the parameters are indicated in the unit of length given.

3. To determine the parameters of the adipocytes, adjust the threshold. Go to Image -> Adjust -> Threshold to open the
Threshold window. Select the following settings: Thresholding method: Default; Threshold color: B&W; Color space:
HSB. The picture is now shown in black and white. Adjust the Brightness to clear white adipocytes and to close black
intercellular spaces, as in Fig. 3b.

4. Count the number of adipocyte per µm2 (Figure 3e) with the *multi-point* selection in the toolbar and mark each cell for
counting.

5. To determine the adipocyte size, select *Straight line* again in the toolbar and draw the diameter of an adipocyte (Figure
3c). Go to Analyze -> Measure and a new window will appear, with the length of the diameter in µm.

6. To determine the adipocyte area, select *Wand (tracing) tool* and click inside the adipocyte. The inner wall of the
adipocyte is selected in red (Figure 3d). Go to Analyze -> Measure and a new window will appear, with the area of this
adipocyte in µm2.

3. For immunohistochemistry, prepare the section for antibody and TdT-mediated dUTP-biotin nick end labeling (TUNEL) staining as
follows:

1. Deparaffinize sections by washing 3 times for 5 min in xylene and rehydrate the section 2 times for 2 min in 100% ethanol and 2
times for 2 min in 96% ethanol. Finally, wash the section in distilled H2O.

2. For antigen retrieval, digest the tissue section for 30 min at 37 °C with Proteinase K working solution (20 µg/ml in 10 mM Tris/
HCl, pH 7.4-8) and rinse with PBS.

4. Perform antibody staining in wet chambers:
1. To block the endogenous peroxidase, use 3% hydrogen peroxide in PBS for 10 min, with subsequently washing 2 times for 5

min in PBS. To block the unspecific binding of antibodies, use 10% serum in PBS. Use the serum of the host of the secondary
antibody, in this case goat.
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2. For the staining, use the antibodies for apoptosis, proliferation and hypoxia detection (Table 4). Dilute antibodies in PBS/10%
goat serum. Incubate at 4 °C overnight. Wash the sections 3 times for 5 min in PBS.

3. To enhance the signal use a biotinylated secondary antibody, with the dilution as listed in Table 5. For hypoxia detection, use
HRP conjugated rabbit anti-FITC as the secondary antibody. Incubate for 1 hr at room temperature. Wash the sections 2 times 5
min with PBS.
 

Note: For the hypoxia staining with FITC-MAb1, skip step 1.4.4.4) and continue with step 1.4.4.5).
4. For each slide, pre-incubate 50 µl avidin solution with 50 µl biotinylated peroxidase H for 30 min at room temperature (this

method is also referred to as avidin/biotin ABC complex formulation) and then add to the sections for another 45 min. Wash 2
times for 5 min with PBS.

5. Incubate the sections in peroxidase substrate solution until the staining become more intense (between 5 to 10 min). Wash for 5
min with distilled H2O.

6. For counterstaining, stain with hematoxylin diluted 1:5 with distilled H2O for 10 min at room temperature and wash in H2O for 5
min.

7. Dehydrate sections in 96% ethanol and 100% ethanol 2 times each for 2 min, and xylene 3 times for 5 min. Seal the sections
with coverslips and anhydrous mounting agent. Evaluate the sections under a bright-field microscope.

5. Determine apoptosis by TUNEL assay and follow manufacturer's instructions:
1. Add 50 µl enzyme solution into 450 µl label solution. Then apply 50 µl TUNEL reaction mixture on histologic sections and

incubate for 60 min at +37 °C in a humidified atmosphere in the dark. Wash the sections 3 times with PBS for 5 min and mount
with fluorescence mounting medium including DAPI (4',6-diamidino-2-phenylindole) for counterstaining.

2. Evaluate the section under a fluorescence microscope with 100 fold magnification. For measurement of Fluorescein use an
excitation wavelength of 488 nm and detect between 515-565 nm (green laser); DAPI excites at about 360 nm and emits at
about 460 nm when bound to DNA (blue laser).

3. Quantify the overlays of DAPI and Fluorescein:
 

 

Figure 3: Analyzing adipocyte characteristics in fat pad sections. Section pictures of the perigonadal fat pad of male mice treated with a
high-fat diet (HFD) or normal diet (ND) with a bright-field microscope (a); the threshold is adjusted into black and white (b) and the adipocyte size
(length; c), area (d) and adipocyte cell number per mm2 (e) are quantified with ImageJ 1.48v. Please click here to view a larger version of this
figure.

Stock concentration dilution

Apoptosis Cleaved Caspase-3 (Asp175) (5A1E) Rabbit
mAb

1:2,000

Proliferation Purified Mouse Anti-Human Ki-67  Clone
 B56 (RUO)

1:50

HIF-1 alpha Antibody 1:100Hypoxia

FITC-MAb1 1:100

Table 4: Antibodies with respective dilution used for the immunohistological staining of AT sections.
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Antibody dilution

biotinylated anti mouse IgG (H+L) 1:200

biotinylated anti mouse IgG (H+L) 1:200

HRP conjugates rabbit anti-FITC 1:100

Table 5: Secondary antibodies with dilution used for immunohistological staining.

2. In Vitro Analysis of Adipocyte Homeostasis Influenced by Hypoxia

1. Sacrifice mice and remove the subcutaneous adipose tissue.
1. Sacrifice the mice by CO2 asphyxiation and subsequent cervical dislocation.
2. Pin down the limbs of mice as illustrated in Figure 4. Detach the skin from the upper leg, loin and flank and pin it down with needles

as in Figure 4. Then remove the subcutaneous adipose tissue, which is located posterior at the base of the hind legs, surrounding the
inguinal lymph nodes (as shown in Figure 4, left: subcutaneous fat pads indicated by the arrows; right: inguinal lymph node indicated
by the arrow).

 

Figure 4: Location of the subcutaneous fat pads. Picture of subcutaneous fat pad; the left arrows indicate the subcutaneous fat pad and the
right arrow indicates the inguinal lymph node. Please click here to view a larger version of this figure.

2. Isolate adipose-derived stem cells (ADSC) as previously described 20.
3. Seed ADSC 4,000 cells/cm2 in Dulbecco's modified Eagle's medium-Ham's F-12 supplemented with 10% normal calf serum, 1% penicillin/

streptomycin, 0.5% amphotericin B, 16 µM biotin, 18 µM pantothenic acid and 100 µM ascorbic acid and grow culture to confluence around
70 to 80%, which is reached after 4 to 6 days of culture.

4. Induce Adipogenic Differentiation.
1. Remove the adherent ADSC from the surface by trypsin treatment.

1. Remove medium, wash with PBS and add 0.025% trypsin solution (preheated to 37 °C) for 2 min (until cells detach from the
surface). Immediately add medium and wash the cells.

2. Count the cells using a Neubauer chamber.
1. Put the glass cover on the central area of the Neubauer chamber. Dilute the cell suspension 1:10 and load the chamber with 10

µl diluted cell suspension. Count the cells in 4 squares located at the corners, each composed of 16 smaller squares. Calculate
the cell number per ml:
 

3. Seed ADSC (as described in point 2.2) in 12-well culture plates and grow culture to confluence around 70 to 80% (reached after 4 to 6
days).

4. Induce adipogenic differentiation by adding 5 µg/ml insulin, 1 µM dexamethasone and 5 µM 3-isobutyl-1-methylxanthine (IBMX) to the
cultures. Renew the medium every 2 days. Cells will be fully differentiated after 7 days.

5. To analyze the adipogenic differentiation, stain with Oil Red O, which stains triglycerides of mature adipocytes.
 

Note: Work must be performed under a fume hood!
1. Remove the medium, wash the adipocytes gently with PBS and fix the cells for 60 min with 2 ml 10% formalin.
2. To prepare Oil Red O staining solution, mix 3 parts of the Red Oil O stock solution (300 mg Red Oil O powder dissolved in 100 ml 99%

isopropanol) with 2 parts distilled H2O and incubate for 10 min at room temperature. Filter the Oil Red O working solution through a 0.2
µm injection filter.
 

Note: The working solution is stable for 2 hr.
3. For the Oil Red O staining, remove the formalin, wash adipocytes with H2O, incubate with 2 ml 60% isopropanol for 5 min, remove the

isopropanol and add 2 ml Oil Red O working solution for 5 min. Rinse the cells with tap water until the water is clear. Counterstain with
hematoxylin as in point 1.4.4.5).
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4. Evaluate the plates under a phase contrast microscope with 100 fold magnification. The lipids of the adipocytes will appear red and the
nuclei will appear blue.

6. Optional step: Silence the gene of interest by transfection with shRNA.
1. Change the medium and add serum-free medium.
2. For the transfection of adipocytes, use lipofection. Follow the manufacturer's instructions and use 1 µg shRNA per 12-well tissue

plates. After addition of the lipid-DNA-complex, incubate adipocytes for 48 hr at 37 °C.

7. To analyze adipocytes subjected to hypoxia, use a hypoxic work station or hypoxic incubator to maintain the cells under hypoxic conditions.
Depending of the study, hypoxia could be 0.5, 1 or 2% oxygen.

1. Analyze apoptosis by FITC-labeled Annexin V and subsequent flow cytometry analyses.
1. Gather adipocytes with an extra soft cell scraper, wash with PBS and add 1 x 106 cells to 100 µl Annexin V-binding buffer (10 mM

Hepes/NaOH, pH 7.4; 140 mM NaCl; 2.5 mM CaCl2). Add the amount of Annexin V-FITC recommended by the manufacturer
and incubate at room temperature for 15 min.

2. For flow cytometry measurement, add 200 µl Annexin V-binding buffer and 1 µM of nuclear counterstain. Determine the
fluorescence in the green and violet channel. Annexin V+/nuclear counterstain+ cells are defined as secondary necrotic and
Annexin V+/nuclear counterstain- cells are defined as apoptotic cells (Figure 5).

2. Quantitatively analyze adipocyte RNA level to determine the homeostasis under hypoxic conditions.
1. Add 1 ml single-phase solution of guanidine isothiocyanate and phenol to each well and isolate the RNA [using single-step

method by Chomczynski and Sacchi 17 (step 1.3.2)] and proceed as in steps 1.3.2.1) to 1.3.5.2).

 

Figure 5: Adipocyte apoptosis analysis by flow cytometry. Dot plot presentations of the FACS for Annexin V-FITC and TO-PRO-3 staining of
adipocytes. Please click here to view a larger version of this figure.

Representative Results

We show how to determine adipocyte homeostasis in vivo and in vitro using the example of Fra-2fl/fl Fabp4-CreERT mice compared to wild-type
littermates. Our protocol defines how increased HIF expression by hypoxia is correlated with adipocyte dysfunction as indicated by increased
adipocyte apoptosis.

Increased adipocyte size and area in high-fat diet (HFD) treated mice

Over-nutrition, among other factors, results in adipocyte hypertrophy, caused by excessive energy storage in the lipid droplets. The adipocyte
size and area is an indicator of hypertrophy. Sections of the fat pad from normal (ND; Figure 6a) and high-fat diet (HFD; Figure 6b) mice as
well as quantifications of the adipocyte size and area clearly show adipocyte hypertrophy after 6 weeks of HFD, which is indicated by increased
adipocyte size in the HFD treated mice (Figure 6c and d).

Increased hypoxia in the adipose tissue (AT) of adult Fra-2fl/fl Fabp4-CreERT mice leads to increased HIF-1α level and adipocyte apoptosis

To determine the in vivo status of hypoxia in AT, Fra-2fl/fl Fabp4-CreERT mice are analyzed 6 weeks after Fra-2 deletion at the age of 12
weeks and compared with wild-type littermates. Pimonidazole is administered to the mice intraperitoneally as an effective hypoxia marker; it is
nontoxic and able to distribute into the AT. Hypoxic adipocytes in the AT in vivo are defined by immunohistochemical antibody staining (Figure
7a). Furthermore, the increased hypoxic status of the AT in mice is accompanied by increased HIF-1α positive adipocytes as indicated by the
immunohistochemical staining Figure 7b), which is confirmed by quantification of HIF-1α expression levels and its targets genes 9. Additionally,
TUNEL staining of AT sections from Fra-2fl/fl Fabp4-CreERT mice and control littermates (Figure 7c) shows that increased adipocyte apoptosis is
correlated with the presence of hypoxia and HIF-1α expression.
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Increased HIF-1α expression in primary adipocytes through hypoxia induced adipocyte apoptosis

To analyze adipocyte apoptosis in vitro, we use adipocytes generated from subcutaneous fat pads as described elsewhere 20. As expected, the
HIF-1α expression in adipocytes is increased after 24 hr of hypoxia (Figure 8a). To further analyze HIF-1α activities, the RNA levels of HIF target
genes such as Inos (inducible nitric oxide synthase) are quantified by qPCR. Figure 8b shows that the increased expression of HIF-1α under
hypoxic conditions leads to increased Inos mRNA level. Since we have already shown in vivo (Figure 8) that increased HIF-1α expression in
adipocytes correlates with increased adipocyte apoptosis, apoptosis is also quantified in in vitro cultures by Annexin V staining under hypoxic
conditions. Consistent with the in vivo data (Figure 7), an increased HIF-1α level is accompanied by increased adipocyte apoptosis induced
by hypoxic conditions (Figure 8b). Moreover, to prove that hypoxic-induced apoptosis is HIF-dependent; HIF-1α or HIF-2α is silenced by RNA
interference in adipocytes derived from wild-type or Fra-2 deficient mice. The increased adipocyte apoptosis is restored by silencing HIF-1α or
HIF-2α as shown by Annexin V staining in Figure 8b, proving that the hypoxia sensor HIF-α regulates the adipocyte apoptosis.

 

Figure 6: Increased adipocyte size and area in high-fat diet (HFD) mice. (a, b) H&E staining of sections from the perigonadal fat pad of male
wild-type mice fed with normal diet (ND) (a) or high-fat diet (HFD) (b) for 6 weeks. Bars represent 500 μm. (c, d) Quantifications of adipocyte size
(c) and area (d) from the perigonadal fat pad of wild-type mice fed with ND (a) or HFD (b) for 6 weeks. n = 10. Data are shown as mean values ±
SEM. Statistical analysis was performed using Student´s t-test. ***p <0.0001.Please click here to view a larger version of this figure.
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Figure 7: Increased HIF-1α level and apoptosis in adipocytes of adult Fra-2fl/fl Fabp4-CreERT mice. Hypoxia (a) and HIF-1α (b) staining in
the AT of male Fra-2fl/fl Fabp4-creERT mice and male control littermates 6 weeks after tamoxifen injection. Magnification 20X, insert 40X. Black
arrows indicate hypoxic areas and HIF-1α positive cells. (c) TUNEL staining in Fra-2fl/fl Fabp4-CreERT mice and control littermates AT 6 weeks
after tamoxifen injection. Magnification 20X, insert 40X. Black arrows indicate TUNEL positive cells. This figure has been modified from Luther et
al. 9. Please click here to view a larger version of this figure.
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Figure 8: Increased HIF-1α expression and adipocyte apoptosis in primary adipocytes induced by hypoxia. (a) Real-time PCR analysis
of HIF-1α and HIFs target Inos mRNA levels in primary adipocytes placed in hypoxic chambers analyzed at the indicated time points. (b)
Quantification of apoptosis by Annexin V FACS staining in primary adipocytes isolated from Fra-2fl/fl Fabp4-CreERT mice or wild-type controls
transfected with sh control or sh plasmid against HIF-1α or HIF-2α and placed under hypoxia (1% O2) for 24 hr. This figure has been modified
from Luther et al. 9. Data are shown as mean values ± S.D. Statistical analysis was performed using Student's t-test. *P <0.05 and **P <0.01
were accepted as significant. Please click here to view a larger version of this figure.

Discussion

Adipocytes are characterized phenotypically by their size, numbers and area, revealing adipocyte hyperplasia and hypertrophy, induced by
excessive energy storage due to over-nutrition 5. These events leading to fatty acid dysregulation and subsequent metabolic syndromes are also
states of increased fat mass with preserved metabolisms, which is also referred to as "healthy" fat expansion. For example, Kusminski et al. 21

showed that mice with massive fat expansion remain metabolically healthy, suggesting that fat expansion is not necessarily linked to metabolic
syndromes and needs to be carefully determined to evaluate the characteristics of the adipocytes. The adipose tissue (AT) plays a pivotal role
in the regulation of body metabolism. AT is the biggest endocrine organ that could influence dyslipidemia, atherosclerosis, hyperinsulinemia
and hyperglycemia 3. Evaluating AT homeostasis and the molecular mechanisms regulating it could allow a better understanding of metabolic
system disorders. Therefore, unravelling the mechanisms regulating adipocyte differentiation, adipocyte size and fat pad mass would help to
develop new therapeutic treatment for obesity disorders. Using in vivo and in vitro methods, it is possible to determine the role of food and gene
expression impacts on adipocyte differentiation and activity. To determine the AT homeostasis, determining the balance between adipocyte
differentiation, proliferation and apoptosis as suggested by our protocol is as important as analyzing the glucose and insulin metabolic response
22-24.

Expression profiling analyses of genes involved in adipogenesis, lipogenesis, lipolysis, fatty acid uptake, hypoxia, apoptosis and proliferation
in primary adipocytes and visceral AT is a high throughput method for obtaining an overview on adipocyte homeostasis and their possible
dysfunction. Interesting candidates should be further analyzed at the protein level by western blot or immunohistological staining. To obtain
optimal results through real-time PCR system using unsymmetrical cyanine dyes, the concentrations of cDNA ranging from 1 to 10 ng and the
optimal primer concentrations ranging from 50 to 900 nM should be tested to minimize nonspecific amplification. The critical components are
the primers; for each run, the melting curves need to be strictly controlled to ensure the specificity and to exclude the formation of primer dimers.
Therefore, using a negative control with H2O instead of cDNA is recommended. Furthermore, commercial available unsymmetrical cyanine dyes
are provided as master mixes that contain a passive reference dye (such as ROX) to provide an internal reference signal. The cDNA signal is
normalized during data analysis to the ROX signals to correct well-to-well signal fluctuations. Another point to be considered in order to establish
a good qPCR system is the choice of the housekeeping gene. For each condition, several housekeeping genes are used, e.g., HPRT, β-actin,
GAPDH, β-2-MG or HSP90.
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HIF proteins stabilized by hypoxic conditions are master regulators determining not only adipocytes survival, but also metabolic changes, such
as glucose, insulin tolerance and lipid metabolism 11,25,26. To ascertain hypoxic areas in the fat pad, HIF-1α is determined in AT sections by
immunohistochemistry. Since HIF proteins are rapidly degraded within 5 to 10 min under normoxic conditions, the procedure and the fixation
of the fat pad for the histological analysis should be tightly controlled to avoid latency time. Therefore, to ensure hypoxia not only through HIF
staining, pimonidazole is used to determine hypoxic areas in the AT. Pimonidazole is able to distribute into tissues, as it was already shown
in bones 27, and effectively mark hypoxic areas by binding to thiol-containing proteins specifically in hypoxic cells, which is further detected in
histological sections by specific antibody binding 28. However, other markers and methods can be used to analyze the hypoxia pathway. For
example, the involvement of the prolyl hydroxylase (PHD) enzyme, which induce hydroxylation of proline residues under normoxia, as well as
the von Hippel-Lindau (VHL) protein, which recognize hydroxylated prolines and induce the poly-ubiquitination to mediate proteasomal HIF
degradation, need to be analyzed for a full overview of the pathway 29,30. Moreover, ubiquitous detection of HIFs would also determine the protein
stability and degradation that can be alter 31,32.

Furthermore, proliferation by Ki67 and apoptosis by TUNEL staining are determined in vivo through staining of AT histological sections.
Quantification of proliferation by Ki67 and apoptosis by TUNEL or Annexin V staining through flow cytometry analysis is also carried out 33.
Proliferation could of course be measured by other techniques such as the analyses of the adipocyte cell cycle, which is not addressed by the
measurement of Ki67 positive cells. Moreover, apoptosis study by TUNEL can be completed by FACS analyses of Annexin V and TOP-PR-3
which will determine the levels of necrosis versus the apoptosis cell death process. Apoptosis is a fundamental process for the program of
cell death, which is important for AT homeostasis. Indeed, dysregulation of adipocyte apoptosis has been implicated previously in processes
contributing to obesity and lipodystrophy 34. Moreover, in 2011, Keuper et al. linked adipose tissue inflammation to adipocyte apoptosis.
They showed that macrophages induced apoptosis in preadipocytes and adipocytes, which in turn attract macrophages. The recruitment of
macrophages accelerates inflammation, which contributes to metabolic syndromes such as glucose and insulin tolerance 35. However, adipocyte
apoptosis is still a poorly studied phenomenon, despite the hypothesis that induced adipocyte apoptosis could lead to decreased weight.

The present protocol uses immunohistochemical approaches to study different phenomenon such as proliferation, apoptosis and hypoxia in
vivo. Therefore, the tissue was fixed with 4% formaldehyde, which is a critical step. An extended tissue fixation time leads to change of the
epitopes, which become non-accessible for the antibody. In contrast, a short fixation time increases the sensitivity of epitopes to reagents. The
recommended optimal time of fixation is 24 hr. Moreover, the thickness of the sections also influences the antibodies binding to their epitopes;
optimal thickness is between 2 and 5 µm. Sections thicker than 5 µm will give false positive results due to increased binding sites. In contrast,
sections thinner than 2 µm contain less binding sites and positive areas are not well defined. Further critical factors are the antibody itself,
incubation time, concentration and even temperature, which influence the quality of the specific binding to the epitopes. Therefore, validating
antibody concentration and incubation time is necessary for each condition.

To complete the study, we provide an in vitro adipocyte differentiation protocol, which could be extended by different treatments, stimulation
or co-cultures. By using in vitro adipocyte cultures, it is feasible to determine defects in adipocyte differentiation and functions. To obtain
reliable results, as for all primary cells, the healthy behavior and appearance of the ADSCs and adipocytes is quite important. The granularity,
cytoplasmic vacuolations and/or detachment are signs of deterioration, indicating inadequate medium, microbial contamination or senescence
of the primary cells. This protocol is using isolated adipocytes from the fat pad tissue, whereas it is as well possible to use mesenchymal stem
cell isolated from bone marrow as described by other protocols 36. The latest includes stromal progenitor cells, which might reflect additional
differentiation problems occurring at the very early step of adipocyte differentiation, this might be missed in our current protocol. Moreover,
ADSCs can be expanded rapidly (more than 10 times within one week), and long-term cultured ADSCs after some passages still retain their
mesenchymal pluripotency 37,38. Another advantage using ADSCs is that one can easily switch to human, since ADSCs can be harvested from
patients by liposuction which is a simple and minimally invasive method.

As AT influences several other organs in an endocrine manner, the protocol should be extended to adipokines. Adipokines, such as leptin,
adiponectin, tumor necrosis factor-α (TNF) and resistin, secreted by adipocytes are known to affect metabolic diseases by controlling fat
metabolism, energy homeostasis and insulin sensitivity 39. Therefore, serum and adipocyte secretome analyses should be performed. In the
case of AT dysfunction, adipokines and pro-inflammatory cytokines, such as IL-6, can lead to dysregulation of organs such as the liver and
pancreas, and of muscle function 4. In order to exclude systemic organ dysfunction, animal models or cell cultures could be tested for their
response to glucose stimulation and uptake.

Here we provide a protocol for analyzing the basic state of the AT and adipocytes in vivo and in vitro to reveal molecular mechanisms of
adipocyte homeostasis and functionality.
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